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1. Introduction to Kernel for SharePoint Server 

Welcome to the user manual for Kernel for SharePoint Server, the most effective and outstanding recovery 
tool for MS SharePoint Server that recovers files from corrupt MDF database. This user manual comprises 
step by step guidelines on using Kernel for SharePoint Server. 

1.1  Using this Manual 

This user manual is intended to guide users on using Kernel for SharePoint Server. We suggest that first 
time users should read this user manual completely and carefully before proceeding to use the software. 
However, if you are an experienced user, you can use the table of contents to find out information 
pertaining to the tasks that you need to perform by using Kernel for SharePoint Server. You can use the 
table of contents to navigate through different sections of this user manual. The table of contents lists all 
the sections that are contained in this user manual in chronological order. The user manual comprises the 
following sections: 

 Introduction 

 Getting Started 

 Software Interface 

 How to Use Kernel for SharePoint Server? 

 Saving Recovered Data 

 Creating and Saving Report 

 Full Version 

 Support 

 Troubleshooting 

 Legal Notice 

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of 
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual. 

1.1.1 List of Abbreviations 

MS: Microsoft 

RAM: Random Access Memory 

MB: Mega-Byte 
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GB: Giga-Byte 

1.2  About Kernel for SharePoint Server 

Kernel for SharePoint Server is database recovery software that extracts files and documents from MS 
SharePoint Server database and enables users to access the important files once again. 

Kernel for SharePoint Server provides two repairing modes with which the MDF SharePoint database can 
be repaired online and offline; Raw File and Live SQL Instance. 

‘Raw file mode’ is an offline option where the user can repair orphan .MDF database and recover the 
documents. The ‘Live SQL Instance’ mode benefits the user to get connected online to MS SharePoint 

Server, select the MDF database and perform the data recovery operation. 

Along with the two excellent modes, Kernel for SharePoint Server also facilitates users to test the SQL 
connections with UDL files and generate HTML reports for the recovered results. 

Use of Kernel for SharePoint Server becomes indispensable in the cases of: 

 Accurate and successful recovery of files from corrupt MDF database 

 Rebuilding of databases and uploading again to MS SharePoint Server 

 Document recovery when MDF database is corrupt and MS SharePoint Server is down 

 Access important shared files that have become inaccessible due to corruption of MDF database 

 Effortless and convenient extraction of files and folders from corrupt database 

Kernel for SharePoint Server provides users with flawless and effortless document recovery and makes 
the corrupt files and files accessible once again. 

1.3 Salient Features 

Salient features of Kernel for SharePoint Server include: 

 Extract files from MDF Database that is corrupt by employing embedded recovery algorithm 

 All recovered files are restored in new database, which is again configured on MS SharePoint Server 

 Maintains data integrity and security 

 Report creation options for checking recovery degree 

 Multiple recovery modes to perform recovery according to the requirement 

 User friendly graphical user interface 

 Free evaluation version to analyze the capabilities of the tool before purchasing it 
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1.4 Who Should Use this Software? 

Kernel for SharePoint Server is an apt solution for MS SharePoint database administrators to deal with 
MDF database corruptions. MDF database that contains all files, folders and documents usually get 
corrupt and become inaccessible and hence, organizational work flow gets affected, as users are unable 
to access the important data and files. Kernel for SharePoint Server recovers files from MS SharePoint 
Server making the inaccessible documents accessible again. 

Some of the reasons which create need for SharePoint Server Document Recovery software are: 

 Lost Document Libraries 

 Accidental file deletion on WSS Websites 

 Server downtime and data inaccessibility due to drive failures 

 Failed backups / Backups turn bad 

 Inaccessibility of server due to virus attacks or human errors 

1.5 How does Kernel for SharePoint Server Works? 

Organizations employ MS SharePoint Server with a motive to enhance the data integrity level and make 
collaborative activities easy; in fact, MS SharePoint Server as portal collaboration software meets all their 
expectations. MS SharePoint Server is outfitted with exclusive features that prove its importance in 
successful accomplishment of major collaborative activities of any organization. As far as security is 
concerned, MS SharePoint Server provides any organization with additional level of security and data 
integrity. 

But there are times when database that contains SharePoint data or MS SharePoint Server or both get 
corrupt and in such a situation, an efficient and hi-tech data recovery solution is required. Kernel for 
SharePoint Server is an apt solution, which performs efficient recovery and extracts all files and folders 
from corrupt database. Moreover, files that have been deleted through logical deletion can also be 
recovered with Kernel for SharePoint Server.  Let us have a look at the process that Kernel for SharePoint 
Server follows for recovering files from corrupt MDF database: 

 Normally, any requested data is processed via MS SharePoint Server and MS SQL Server but in 
case of SharePoint Server and MDF database corruption, the requested data becomes 
inaccessible. Kernel for SharePoint Server eliminates the dependency on MS SharePoint Server 
and enables the administrator to extract files from MDF Database that is corrupt. 

 Kernel for SharePoint Server recovers files from corrupt MDF database through establishing 
connection with that database, which is stored in SQL Server. 

 All recovered files are further restored in new database and the database is again conf igured on 
MS SharePoint Server. 
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2. Getting Started 

Now that you have understood the features and potential of Kernel for SharePoint Server, you are ready to 
get hands on experience of the software. To start the recovery process, you will first need to download 
and install this software. However it is strongly recommended that before installing Kernel for SharePoint 
Server, you should go through the installation pre-requisites for the software to ensure that your computer 
is appropriately configured to run the software. 

2.1 Installation Pre-requisites  

The various pre-requisites for installing and running Kernel for SharePoint Server can be broadly classified 
into two major categories ï Hardware requirements and Software requirements. 

2.1.1 Hardware Requirements: 

The hardware requirements for installing the software are as follows: 

 Pentium class processor 

 Minimum 64MB RAM (128 MB recommended) 

 10MB for Software installation 

 Disk Space - Enough space to store the recovered files 

@ You should have at-least 40 MB of free disk space if you want to recover and save 

40 MB .MDF files. 

2.1.2 Software Requirements: 

The software requirements for installing the software are as follows: 

2.1.2.1 Operating System Requirements 

Supported operating systems: 

 Windows Vista 

 Windows XP 

 Windows Server 2003 

 Windows 2000 

2.1.2.2 MS SQL Servers Requirements 

Supported MS SQL server versions: 
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 MS SQL Server 2000 

 MS SQL Server 2005 

 MS SQL Server 2008 

2.1.2.3 MS SharePoint Server Requirements 

 MS Office SharePoint Server 2007 

2.2 Downloading Kernel for SharePoint Server for the First Time 

After checking your computer with the prescribed system requirements for Kernel for SharePoint Server, 
you can download and install the software on your computer. You can buy the full version of the software 
from any one of our authorized resellers ï Element5, Asknet and 2CO. 

If you want to try using Kernel for SharePoint Server before buying it, you can download the evaluation 
version from the following link: 

http://www.nucleustechnologies.com/download-sharepoint-document-recovery.html 

@ You can recover and extract documents from SharePoint database by using the 
evaluation version of Kernel for SharePoint Server; however, the recovered files and 

folders will not be saved until you purchase the full version of the software. 

2.3 Install Kernel for SharePoint Server 

After downloading the installer file for Kernel for SharePoint Server, you can install the software by running 
the file. 

To install Kernel for SharePoint Server: 

1. Double-click the Kernel for SharePoint Server installer. 

2. Follow the on-screen instructions. 

The Setup Installation Complete screen will be displayed. 

3. Click Finish to launch the software. 

2.4 Start Kernel for SharePoint Server 

To start Kernel for SharePoint Server: 

Click the Start Ą All Programs ĄKernel for SharePoint Server 

Alternatively, you can launch Kernel for SharePoint Server by double-clicking the shortcut icon available 
on the desktop and Quick Launch icon. 

http://www.nucleustechnologies.com/download-sharepoint-document-recovery.html
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2.5 Uninstall Kernel for SharePoint Server 

You may need to uninstall and re-install Kernel for SharePoint Server. 

To uninstall Kernel for SharePoint Server: 

1. Click the Start Ą All Programs ĄKernel for SharePoint Server Ą Uninstall Kernel for SharePoint 
Server 

A warning message will be displayed. 

2. Click óYesô to uninstall Kernel for SharePoint Server. 

@ Before proceeding to uninstall Kernel for SharePoint Server, you must ensure that 

the software is not running in the system background. 

You can alternatively uninstall Kernel for SharePoint Server from the Control Panel by performing the 
following steps: 

1. Click the Start Menu Ą Control Panel and then double click the Add or Remove Programs icon. 

2.  Select Kernel for SharePoint Server and click Remove. 

A warning message will be displayed. 

3. Click óYesô to uninstall Kernel for SharePoint Server. 
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3. Software Interface 

Now that Kernel for SharePoint Server has been installed on your computer, you can start using the 
software after getting acquainted with the software interface. 

3.1 Menu-bar 

The menu-bar of Kernel for SharePoint Server comprises two main menus ï File and Help. 

3.1.1 File Menu 

The File menu comprises three menu items. 

 

Figure: File Menu 

Menu items in the File menu: 

Field Name Field Description 

Open Select to open Database Source Selection window 

Save Select to save the selected files and folders 

Exit Select to close the software 

3.1.2 Help Menu 

The Help menu comprises three menu items: 

 

Figure: Help Menu 

Menu items in the Help menu: 



© N u c l e u s  D a t a  R e c o v e r y . C o m  P r i v a t e  L i m i t e d        

Field Name Field Description 

Software Help Select to view the user manual of Kernel for SharePoint 
Server 

Software Homepage Select to go to the homepage of software website 

About Kernel for SharePoint 
Server... 

Select to view version-related and support information of    
Kernel for SharePoint Server 

3.2 Tool-bar 

The tool-bar in Kernel for SharePoint Server is displayed below the menu-bar. The tool-bar provides a 
convenient and user-friendly method to perform certain actions that can also be performed by using the 
menu-bar. Read the information in the table below to find out about the tool-bar buttons: 

 

Button Button Name Button Description 

 

Open Opens the Database Source Selection window 

 

Save Saves the selected files and folders 

 

Help Opens the user manual of Kernel for SharePoint 
Server 

 

Buy Online Opens the website to purchase the software 
online 
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3.3 Status Bar 

Status bar is displayed at the bottom of the software window. The text óReadyô is displayed on the status 
bar if Kernel for SharePoint Server is ready to be used. Status bar also displays the text óCAPô, óNUMô, 
óSCRLô which respectively correspond to the Caps Lock, Num Lock, and Scroll Lock keys on your 
keyboard. If any of these keys are pressed, the color of the corresponding text will turn blue/black. 

 

Figure: Status Bar 

3.4 Left Panel 

Left Panel of Kernel for SharePoint Server displays recovered SharePoint folders and their sub folders in a 
hierarchical manner. Folders that are displayed at the left panel for Kernel for SharePoint Server are: 

 Tables 

 SharePoint 

 SharePoint Actual 

 

Figure: Left Panel 
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@ If the recovery is done through Live SQL Instance, the left panel will display only 
SharePoint and SharePoint Actual folders. 

3.5 Right Panel 

Right Panel of Kernel for SharePoint Server displays the content of subfolders. The file information is 
displayed along with details like File Name, File Type, Version, Last Modified Time, Creation Time and 
User name. 

 

Figure: Right Panel 
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4. How to use Kernel for SharePoint Server? 

Now that you have complete familiarity of the user interface of Kernel for SharePoint Server, you are ready 
to perform the SharePoint document recovery from the inaccessible SharePoint Server database. Kernel 
for SharePoint Server provides two modes of recovery: Raw File Mode and Live SQL Instance Mode. 

Raw Mode of recovery is used where only the MDF database is corrupt and MS SQL Server and MS 
SharePoint Server are in working condition. 

 This recovery mode is applicable in conditions where only database is corrupt. 

 In this recovery mode, MDF database is repaired as an orphan file and items are extracted from it. 

 Use of Orphan database in Raw mode eliminates the dependency of MS SharePoint Server in 
recovery process. 

 Raw Mode recovers Tables, SharePoint and Actual SharePoint folders and allows the user to view 
and save the files contained in these folders. 

 In Raw mode, tables can be recreated by connecting created batch file to the SQL Server 
Database; once the tables are recreated the database is again ready to be configured in MS 
SharePoint Server. 

In cases, where MS SharePoint Server is down or corrupt, Live SQL Instance recovery mode is used. 

This recovery mode is embedded with distinct features, which make it suitable for specified corruption 
conditions. Features of Live SQL Instance Mode are as follows: 

 This recovery mode is applicable in conditions where MS SharePoint Server is down. 

 In Live SQL Instance recovery mode, documents are extracted from the database. 

 Recovered documents can be again uploaded in a new account created on SharePoint Server. 

 UDL file connected to the SQL server can also be used for recovery. 

4.1 Recovery through Raw Mode 

With Raw mode, recovery process can be performed by following these steps: 

1. Click Open from the tool bar or select Open from the File menu. 

@ When Kernel for SharePoint Server is launched, the Source Selection window 
appears by default. You can also start the recovery process by selecting recovery 

mode from Source Selection Window. 

2. A Source Selection window appears. Select Raw File mode and click óNextô. 
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Figure: Select the Database Source 

A new dialogue box ï Select Database Location appears to select the database location. 
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Figure: Select Database Location in Raw File Mode 

3. Click Browse and select the location where the corrupt MDF database is stored. Click Select Temp to 
select the location to save the temporary files which are generated by the software while performing 
various functions. 

4. Select SQL file version and click Finish. 

The recovery process starts and a window showing the process status appears. 
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Figure: Scanning Process – Raw File Mode 

5. Once the recovery process is complete all the recovered Tables, SharePoint Actual and SharePoint 
folders get listed at the left panel of the software. 

 

Figure: Preview Recovered Documents through Raw File mode 

6. Select folders you want to save from the left panel. 

7. Click Save on tool-bar or select FileĄSave from menu bar. 

A dialogue box: Select Path for Saving appears which asks for the saving location. 

8. Browse  for the location where you want to save the recovered files. 
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Figure: Select Path for Saving 

9. Select or de-select the Save in full path checkbox. This option, if checked saves the recovered files 
with complete hierarchy of the table listed in left panel, but if un-checked then the software only saves 
the respective folder with its contents. 

10. Click OK and files get saved in defined location. 

4.2 Recovery through Live SQL Instance Mode 

In cases, where MS SharePoint Server is down, Live SQL Instance Mode is used. To perform recovery 
through Live SQL Instance Mode, two options to connect with the database are available. 

These options are: 

 Connecting through SQL Server 

 Connecting through UDL File 

4.2.1 Connecting through SQL Server 

To perform recovery by connecting with the database through MS SQL server, follow these simple steps: 

1. Click Open from the tool bar or select Open from the File menu. 

2. A new dialogue box - Select the Database Source will appear. Select Live SQL Instance mode and 
click óNextô. 
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Figure: Select Database Source – Live SQL Instance 

3. Select Database Location window appears which asks for server name, authentication and database 
name. Enter the details for the same and click Finish. 
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Figure: Select Database Location – Live SQL Instance 

@ Keep the Use UDL file for connection information option unchecked in this 

recovery process. 

A window showing status of the scanning process appears. 

 

Figure: Scanning and Recovery In Process 
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4. Once the recovery process is complete the recovered SharePoint Actual and SharePoint folders get 
listed at the left panel of the software. 

5. Next steps of saving are same as steps 6 to 10 of above mentioned Recovery through Raw Mode. 

4.2.2 Connecting through UDL File 

Universal Data Link file (.udl) helps to specify connection information to a data provider on Windows 2000 
and above operating systems. Kernel for SharePoint Server helps to achieve quick recovery of files by 
allowing to get connected to the MS SQL Server through UDL file and perform the recovery operation. 

To perform recovery by connecting the database through UDL file, follow the given below steps: 

1. Click Open from the tool bar or select Open from the File menu. 

2. A new dialogue box - Select the Database Source will appear. Select Live SQL Instance mode and 
click óNextô. 

3. For establishing connection with database from which files need to be recovered, enable Use UDL file 
for connection option on Database Location Selection dialogue box. 

 

Figure: Connecting through UDL File 

For connecting with the database with this option, you will need to create an UDL file 
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4.2.2.1 Creating an UDL file 

 Create a New Text Document (.txt) at the desired location. 

 Rename the file to ótest.udlô. 

 Double click the ótest.udlô. Data Link Properties dialogue box will appear. 

 

Figure: Data Link Properties – Provider tab 

 In Data Link Properties dialog box, click Provider tab. 

 Select the Provider that will be used to connect to your database. For example, if you need to 
check the availability of a Microsoft SQL database, you would need to select óMicrosoft OLE DB 
Provider for SQL Serverô. 

 Select the appropriate option and click Next to continue to the Connection tab. The Connection 
tab will request authentication information which is used to access your database. 
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Figure: Data Link Properties – Connection tab 

 Select or enter the Server name and the username and password used to access the database. 

@ You need to select the Allow saving password option for saving the password. If 

the password is not saved at the time of Data Link Properties configuration, the 
software fails to get connected with the database and a message regarding login 

failure appears on the Screen of Kernel for SharePoint Server. 

 Click the Test Connection button to confirm the connection to the server and database using the 

provided information. 

 Open ótest.udlô with notepad. The file will contain a line with your connection string, which will be 
similar to: 

Provider=SQLOLEDB.1;Password=YourPassword;Persist Security Info=True;User 
ID=YourUserID;_Initial Catalog=YourDB;Data Source=YOUR_LOCAL_SERVER_NAME 

4. Once UDL file is created, select Use UDL file for connection and browse the UDL file. 

5. Click Finish. A window showing status of the scanning process appears. 
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6. Once the recovery process is complete the recovered SharePoint Actual and SharePoint folders get 
listed at the left panel of the software. 

7. Next steps of saving are same as steps 6 to 10 of above mentioned Recovery through Raw Mode. 
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5. Saving Recovered Data 

With Kernel for SharePoint Server recovered files can be saved very easily. Recovered files that are 
saved in any specified location are restored according to the mode used for performing recovery process. 
Since Raw and Live SQL Instance recovery modes are used in specific corruption conditions, post-saving 
procedures for making the recovered files accessible again, are different. However, process for saving 
recovered files is same in both modes. 

To save recovered files, you need to follow these steps:  

 Go to the left panel and select folders you want to save. 

 Click Save on tool bar. 

 A dialog box: Select Path for Saving to select the saving path will appear. Type the location or 
Browse the location where you want to save the recovered files on your system. When you click 
Browse, a dialog box to browse the folder will appear. Select the folder or create a new folder to 

save selected files. 

 

Figure: Select Path for Saving 

 Select or de-select the Save in full path checkbox. This option, if checked saves the recovered 
files with complete hierarchy of the table listed in left panel, but if un-checked then the software 
only saves the respective folder with its contents. 

 Click OK and the files will be saved in defined location. 

When using Raw Mode of recovery, Kernel for SharePoint Server generates a Commit.bat file which 
contains the recovered tables from the corrupt MDF file. The Commit.bat file is then easily attached and 
connected to the MS SQL Server and items from recovered tables are restored to new database on the 
server. 

5.1 Process to restore from Commit.bat file 

Follow the simple steps to create new database. 
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1. Go to SQL Server Management Studio. 

2. Create a New Database. 

3. Go to Command Prompt (Start menu->Run-> cmd ) 

4. Change the path to recovered folder ( cd PathName )  

5. Run the Commit.bat file by typing "commit.bat servername newcreateddatabase 
sqlserverusername sqlserverpassword" > press Enter key and all tables will be copied to the new 
created database. 

6. Once all tables are copied in database, the database is ready to be configured in MS SharePoint 
Server. 

@ This option is applicable when only the MDF database is corrupt and recovery is 
performed through Raw recovery mode. 

5.2 Upload recovered files through Live SQL Instance 

When Live SQL Instance mode is used for recovery, SharePoint and SharePoint Actual folders are 
generated. These folders contain all the recovered files, which are further restored in a new account 
configured on MS SharePoint Server. Once new account is created and configured on MS SharePoint 
Server, all files that are recovered through Kernel for SharePoint Server can be uploaded on that account. 
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6. Creating and Saving Report 

Kernel for SharePoint Server generates a list of path location where the files are positioned: SharePoint 
Folder Location and SharePoint Actual Folder Location. Report of extracted files and documents can 

also be saved with Kernel for SharePoint Server in HTML format. 

To save any report, the following steps need to be performed: 

1. At the bottom of the screen a window titled Document List is displayed. This list contains fields such 

as File Name, SharePoint Folder Location and SharePoint Original Folder Location.  

To create report click SharePoint folder location of file for which you want to create report. 

 

Figure: Document List 

@ Document List window also helps to filter or search for specific files and other items 
if you know the saving location of those files. Search and click the appropriate link 

and locate the files.  

The report will get displayed at the right panel. The created report will contain fields like file name, file 
type, version, last modified time, created time and username. 

2. Select the relevant folder to save. 

3. Click Save on tool bar or go to File menu and select Save. 

4. A dialogue box to select saving path will appear. Browse the desired location, select folder and click 
OK. 
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5. If you want to save list content in HTML file, then click Save in HTML option from document list 

window. 

@ Important: To view and hide the Document List window, right-mouse-click the 

Toolbar and check or uncheck the Document List option. 

 

Figure: Show/Hide Document List 

6. A dialogue box to select the saving location will appear. Select the desired location and folder. 
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7. Click OK and the report will be saved in HTML file.  
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7. Full Version 

Although you can use Kernel for SharePoint Server evaluation version for free and experience the 
capabilities of the software, there are certain features that are not available in the evaluation version. 

7.1 Requirement of Full Version 

Kernel for SharePoint Server is available for free trial download. The evaluation version is fully functional 
and provides the user with a fair idea about the efficiency and accuracy of the software. Free version of 
the software displays preview of every file restored and recovered but will not save them. 

You will need to buy the full version of the software to save the recovered files and folders. 

7.2 Purchasing Full Version 

You can buy the full version of Kernel for SharePoint Server from any one of our authorized resellers ï 
Element5, Asknet and 2CO. 

As soon the purchase transaction with our resellers gets completed, our sales team will send you an email 
comprising the URL to download the full version of Kernel for SharePoint Server and activation details of 
the software. 

Buy Kernel for SharePoint Server: http://www.nucleustechnologies.com/buy-sharepoint-document-
recovery.html 

 

  

http://www.nucleustechnologies.com/buy-sharepoint-document-recovery.html
http://www.nucleustechnologies.com/buy-sharepoint-document-recovery.html
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8. Support 

We have an extensive and efficient support system in place to assist our customers with all issues related 
to using Kernel for SharePoint Server. The software comes with an embedded help manual that can be 
accessed by clicking HelpĄSoftware Help in the menu-bar. You can also press the F1 key on the 

keyboard of your computer to access the embedded help of Kernel for SharePoint Server. 

You can access the online help for Kernel for SharePoint Server at 
http://www.nucleustechnologies.com/Online-Helps.html 

We also have live support wherein you can chat with our software experts at 

http://www.nucleustechnologies.com/Support.html . 

To talk on phone with our software experts call: 

Help line:  
 

+91-9818725861 

1-866-348-7872 (Toll Free for USA/CANADA) 

You can also email us about your queries at; 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

  

http://www.nucleustechnologies.com/Online-Helps.html
http://www.nucleustechnologies.com/Support.html
mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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9. Troubleshooting 

This section deals with your generic and specific queries pertaining to using Kernel for SharePoint Server. 

9.1 Common Issues 

Why does Kernel for SharePoint Server have limitations in evaluation copy? 

The free evaluation version of Kernel for SharePoint Server is intended to enable you to experience the 
capabilities of the software. You will need to buy the software to save the recovered files and folders. 

9.2 Frequently Asked Questions 

How to Buy Kernel for SharePoint Server? 

You can buy Kernel for SharePoint Server online at http://www.nucleustechnologies.com/Buy-Data-
Recovery-Software.html 

I have lost my full version for Kernel for SharePoint Server. Can you help me? 

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address, 
and order confirmation number (if you have it). We will be happy to help you. 

  

http://www.nucleustechnologies.com/Buy-Data-Recovery-Software.html
http://www.nucleustechnologies.com/Buy-Data-Recovery-Software.html
mailto:sales@nucleustechnologies.com
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10. Legal Notices 

This section comprises the legal specification about Kernel for SharePoint Server and the company 
NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

10.1 Copyright 

NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, Nucleus Kernel accompanied user manual and 
documentation are copyright of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, with all rights 
reserved. Under the copyright laws, this user manual cannot be reproduced in any form without the prior 
written permission of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. No Patent Liability is 
assumed, however, with respect to the use of the information contained herein. 

© NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. All rights reserved. 

10.2 Trademark 

Kernel ® is a copyright work of NUCLEUS DATA RECOVERY.COM. 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP®, MS SharePoint Server and MS SQL Server 
are registered trademarks of Microsoft Corporation.  

All other brand and product names are trademarks or registered trademarks of their respective companies. 

10.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED provides no warranty 
with regard to this manual or any other information contained herein and here by expressly disclaims any 
implied warranties of merchantability or fitness for any particular purpose with regard to any of the 
foregoing NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED assumes no liability for any damages 
incurred directly or indirectly from any technical or typographical errors or omissions contained herein or 
for discrepancies between the product and the manual. In no event shall NUCLEUS DATA 
RECOVERY.COM PRIVATE LIMITED, be liable for any incidental, consequential special, or exemplary 
damages, whether based on tort, contract or otherwise, arising out of or in connection with this manual or 
any other information contained herein or the use there of. 

10.4 License Agreement 

Kernel for SharePoint Server Copyright © by Nucleus Data Recovery.com 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 
software, unless you have a different license agreement signed by NUCLEUS DATA RECOVERY.COM. 
The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 
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Kernel for SharePoint Server. For purposes of this License, if you have a valid license, you have the right 
to use a single Licensed Copy of Kernel for SharePoint Server. 

Scope of License 

Each Licensed Copy of Kernel for SharePoint Server may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. All 
rights of any kind in Nucleus Kernel, which are not expressly granted in this License, are entirely and 
exclusively reserved to and by NUCLEUS DATA RECOVERY.COM. You may not rent, lease, modify, 
translate, reverse engineer, decompile, disassemble, or create derivative works based on, Nucleus Kernel, 
nor permit anyone else to do so. You may not make access to Nucleus Kernel available to others in 
connection with a service bureau, application service provider, or similar business, nor permit anyone else 
to do so. 

Warranty Disclaimers and Liability Limitations 

Kernel for SharePoint Server and any and all accompanying software, files, data and materials, are 
distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. In 
particular, there is no warranty for the quality of data recovered. You acknowledge that good data 
processing procedure dictates that any program, including Nucleus Kernel, must be thoroughly tested with 
non-critical data before there is any reliance on it, and you hereby assume the entire risk of all use of the 
copies of Nucleus Kernel covered by this License. This disclaimer of warranty constitutes an essential part 
of this License. In addition, in no event does NUCLEUS DATA RECOVERY.COM authorize you or anyone 
else to use Kernel for SharePoint Server in applications or systems where Kernel for SharePoint Server 
failure to perform can reasonably be expected to result in a significant physical injury, or in loss of life. Any 
such use is entirely at your own risk and you agree to hold NUCLEUS DATA RECOVERY.COM harmless 
from any and all claims or losses relating to such unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and 
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, 
obligations or representations made by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED herein. 

Any waiver by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED of any violation of this License by 
you shall not constitute, nor contribute to, a waiver by NUCLEUS DATA RECOVERY.COM PRIVATE 
LIMITED of any other or future violation of the same provision, or any other provision, of this License. 


